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What's New in knonos.factory 1.2.02 (23/12/2023)

¢ Provided a workaround for the OSX Java file selector bug that reports a non existent directory when
you have double clicked a directory to select it.

e Improved registration process. You now no longer have to quit the program to activate the disabled
features once registered and activated.

e Application rebuild to stay current with latest version of Java 17, required libraries and build tools.

Previous Versions
V1.2.01 (20/12/2022)

e You can now double click in a table to select lower level tables rather than using the context menu.
(e.g. Program Bank Collection, Program Banks) and kronos.factory will move down to the next level
until you get to discrete objects (e.g. Program) You can double click with the ALT key (OPTION key
on OS X) held down to traverse upwards

¢ Fixed a "class cast" exception bug when copying a selection of set lists.

e Fixed a bug in drag and drop (most noticeable in kronos.factory and montage.factory due to file sizes)
where drag and drop operations were occasionally failing and providing an error message about copy
and paste not being possible.

e Fixed a bug where using the View/Refresh menu option killed drag and drop.

e Updated the status bar's file name display to show a truncated path (with the filename fully visible) if
the the full path will not fit in the available space.

kronos.factory V1.2.00 (08/05/2022)

¢ Updated how the applications are built. The Java Runtime is now embedded and updated to Java 17
as the minimum version. There is no longer a need for a standalone version of Java to be installed

e New installers for OS X (DMG), PC (MSI) and Linux (DEB) and basic ZIP and TAR packages.

¢ The OS X DMG package is notarized for compatibility with the OS X security model.

V1.1.01 (05/07/2020)

¢ Fixed problem on OS X Mojave and Catalina which was preventing access to protected folders.

V1.1.00 (18/04/2020)

¢ The Minimum Java Version is now Java 11, and | have rebuilt the applications with the latest support
libraries. Please see the Java Support page on the website for more details.
e The applications support iMac Retina displays.

V1.0.00 (01/03/2019)

¢ First Release

V0.5.00 (28/12/2018)

e Added in support to migrate between earlier to later PCG file formats
¢ Wave Sequences further decoded to show the Wave Sequence steps

V0.4.00 (21/12/2018)

e Completed decoding of 1.0, 1.5, 2.0 and 3.0 PCG formats, and extensive file read/write testing.

V0.3.00 (13/12/2018)

* First pass of decoding legacy PCG files completed, and general bug fixing

V0.2.01 (24/09/2018)

¢ Drag and Drop of Combi Timbres now working

¢ Corrected problem with import of PCG files that do not correctly set the size of data chunks

e The Application is now built using new build tools and libraries, as some of the ones | was using were
obsolete and no longer supported. | am changing these as part of longer time migration plans to Java 9 and
above.

e The Minimum Java Version is now Java 8, as Java 7 as Oracle no longer provide public updates to Java 7.

V0.2.00 (28/08/2018)

¢ Drag and drop editing between files now completed down to Level 3 (e.g. Program, Combi), including
copying of referenced objects

What's New in knonos.factory 1.2.02 (23/12/2023) 1
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V0.1.00 (21/02/2018)

¢ Drag and drop editing within a file completed down to Level 3 (e.g. Program, Combi)

V0.0.02 (28/12/2017)

e First set of editing features implemented.

V0.0.01 (04/12/2017)

¢ Improved decoding of referenced objects

V0.0.00 (09/09/2017)

¢ First version with basic decoding of PCG Files completed

What's New in knonos.factory 1.2.02 (23/12/2023)



Installation and Configuration of kronos.factory

kronos.factory is downloaded as a self installing file, so installation is automatic, and for most users little else,
if anything, needs to be done to get up and running.

A native installer for Windows is also available.

Simply download the installer from the x.f ry Pr Page/a> for r platform (P X or Linux
run the installer, following the installer prompts.

Installation and Configuration of kronos.factory
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Registering kronos.factory
You need to register kronos.factory to allow data to be saved to your computer and for Library Support to be
enabled.

Please refer to the x.factory Librarian Registration Page for details on how to register kronos.factory.

Registering kronos.factory
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Running kronos.factory

Starting up kronos.factory is as simple as starting any application, simple double click on the icon and you're
away.

If you have reqistered kronos.factory, then the Library will be created (if it doesn't already exist) and opened.

During start-up, a "Splash Screen" is shown. This stays visible until a few seconds after the program has
loaded and is ready for use, but can be dismissed at any time by clicking on the Splash Screen.

kronos.factory remembers the size and position of the main window between sessions, so the main window
will be sized and positioned as you left it the last time.

PC

Simply double click on the program icon for the program either in an Explorer shell, or from the desktop if you
let the installer placed a shortcut there.

You can also select the program from the Start Menu. By default, kronos.factory can be found under the
x.factory Librarians Program Group.

MAC OS X

Navigate to the Applications folder in Finder and double click the kronos.factory application.
You can also create "Aliases" of the application and place them anywhere you wish, such as on the desktop
To make an alias you can choose any one of the following methods:

e Click the kronos.factory item you have just identified and hold down the mouse button. Then, while
holding down the Command and Option keys simultaneously, drag the item to where you want the
alias to appear then let go of the mouse button and finally release the two keys. This will create an
alias at your desired location. While dragging, the ‘ghosted’ item will display a shortcut arrow which will
remain on the aliased icon when it has been created.

¢ Hold down the Ctrl key, and then click the kronos.factory item as identified previously. The context
menu will be displayed, and one of the choices will be Make Alias. Click that option, and then release
the key. The kronos.factory alias will appear next to the original item and can be dragged to your
location of choice.

e Select the kronos.factory item you identified previously by clicking it once then press Command-I
(lowercase L). The kronos.factory alias will appear next to the original item and can be dragged to
your location of choice.

e Click the kronos.factory item once to select it, and then from the File menu, select Make Alias. The
kronos.factory alias will appear next to the original item and can be dragged to your location of choice.

Note that if your alias does not have a small arrow in the lower left corner then you have not correctly created

an alias and have probably just dragged the application launcher to a new location. If so, drag it back to the
Application folder and start again.

Command Line

You can also startup kronos.factory from a command shell (e.g. MsDOS). Simply change directory to where
kronos.factory is located and type the following:

java -jar exfactory.jar

Running kronos.factory 5



The kronos.factory Window

The main kronos.factory window on OS X looks like this

3 KronosFactory File Edit View Window Help

[ JON kronos.factory - Korg Kronos Librarian

B=eo & ® % ue e (o B (H2 P

The main kronos.factory window on Windows looks like this

|£s kronos.factory - Korg Kronos Librarian  -- (UNLICENSED: Fife Save Disabled — O
File Edit View Window Help

5/al o) (%9 [5]

The kronos.factory user interface is a Multiple Document Interface (MDI), which allows you to have more than
one file open at a time.

The interface is divided into the now familiar layout of (from top to bottom):

e The Title Bar
e The Menu Bar (on OS X this appears at the top of the screen)

The kronos.factory Window 6



e The Tool Bar
¢ The Desktop
¢ The Status Bar

The kronos.factory Window



Menu Bar

The kronos.factory menu bar provides a means of selecting common operations; typically those that affect a
complete file, or those that don't fit naturally upon a context sensitive popup menu.

Keyboard Shortcuts are provided for common operations.
kronos.factory also provides context sensitive popup menus, which are accessible by right clicking over data

shown in a Child Window. Naturally the contents of the popup menus varies according to the type of data over
which the menu was popped up.

Main Menu Headings
The following menu headings are available.

KronosFactory File Edit View Window Help

¢ File Men

e Edit Menu

¢ View Menu

e Window Menu
¢ Help Menu

The kronos.factory Window 8



The Application Menu

The Application menu is available on OS X to provide a native look and feel for OS X users; some menu
options from the standard menus are migrated here (where OS X Users would expect them to be).

About kronos.factory
Preferences...
Services >

Hide kronos.factory
Hide Others
Show All

Quit kronos.factory

About kronos.factory...

This menu provides the standard OS X application menu, with the following kronos.factory specific options
along with the standard OS X options for Services (none defined for kronos.factory) and Window control.

Displays the kronos.factory About Dialog, which provides some basic information about the program, such as
the version number.

Preferences ...

Opens the kronos.factory Preferences Dialog.
Quit kronos.factory

Exits the kronos.factory application.

If any files have been modified and have not been saved, you will be given the option of saving them.

The kronos.factory Window 9



The File Menu

The File menu provides the following options (OS X and Windows versions are shown):

% New ... HEN

&1 Open ... ¥0

Close Hw

Close All 8w

5]

& [ New... Ct

& <3 Open ... Cirl-O
Open Work Space... 0
Save Work Space ... RS

1: /Development/Kronos/Welsh Floyd/Welsh Floyd.PCG
2: [Development/Kronos/Carreg DdufCarreg Ddu.PCG

3: [De../KAPRO/KRS-79 EXi Atmospheres/KRS-79.PCG
4: [De../Kronos/KRS-54 Virtual Analog/KRS-54.PCG .
5: [Development/Kronos/Welsh Floyd Small.PCG Exit

Open Work Space... Chl+AltL

6: /Development/Kronos/DRUM PATTERN TEST.PCG 1: E:\.\Patch ArchivelWelsh Floyd\Welsh Floyd.PCG

7: [Development/Kronos/DRUM KIT TEST.PCG 2: E:\.\Patch Archive\Carreg Ddu 1\Carreg Ddu.PCG

8: /Development/Kronos/INIT1.PCG 3: E:\.\Backups|161226 BACKUP\161226 BACKUP.PCG

9: [De../Kronos/CONTENT TEST/Baseline/Baseline.PCG 4: E:\.JKApro\KR5-33 EXi Atmospheres 3\KRS-33.PCG
New ...

Shows the Create New File Dialog, which allows you to create a new file.
Open ...

Shows the Open File Dialog, which allows you to open a specified file.
Save

Saves a file using its current name.

This option is only enabled if your copy of kronos.factory is registered.

If the file in question is a newly created file, then the Save File Dialog is brought up to allow a name to be
entered.

Save As ...

Saves the selected file after a name has been entered in the Save File Dialog.
This option is only enabled if your copy of kronos.factory is registered.

Save All

Saves all files that have been modified using their current names.

This option is only enabled if your copy of kronos.factory is registered.

Open Workspace ...

This option allows you to select a previously saved Workspace, which is a Collection of open windows, and
their size and position within the main kronos.factory window.

When you select this option, a dialog opens which allows you to select an kronos.factory workspace file
(EXW).

Save Workspace ...

This option allows you to save the current size and position of the main kronos.factory window, and the
arrangement of the open windows within kronos.factory to a Workspace file.

This option is only enabled if your copy of kronos.factory is registered.

The kronos.factory Window 10



Export to
This feature is currently not supported and is disabled. It will be supported in a future version

If you select one of the export sub options in a licensed version of kronos.factory, you will get the following
error dialog

@ kronos.factory

3 Export functions are not yet implemented
Exit

This menu option is not available if the host operating system is OS X. On OSX there is a Quit menu option in
the kronos.factory Application Menu.

Exits the kronos.factory application.
If any files have been modified and have not been saved, you will be given the option of saving them.
Recently Opened Files

The file menu also contains a list of recently opened files to allow easy access to files that you are currently
working upon. The recently open files list appears at the bottom of the file menu.

The kronos.factory Window 11



The Edit Menu

The Edit menu provides the following options:
a
@2

%
5]
@

& Find ... 38F

!
Find Category ... {+38F

Goto ... ®G

Undo

Undoes the previous edit stored in the Undo Buffer.

Redo

Redoes the next edit stored in the Undo Buffer.

Clear Undo Buffer

Clears the Undo Buffer.

Cut

Places a copy of the selected Object(s) onto the Clipboard and deletes the selected Object(s) from the file.
Copy

Places a copy of the selected Object(s) onto the Clipboard.
Paste

Copies the Object(s) on the Clipboard into the highlighted location within the current file. If you cannot perform
a paste at this location (e.g. trying to copy a Set List onto a Program) then this menu item is disabled.

Find ...

kronos.factory supports the ability to find Objects either by name or by category (where an Object supports
categories, such as Programs and Combis).

Searches start from the currently selected Object.

Selecting the Find ... option brings up the Eind dialog, that allows you to specify the string to search for, along
with options that can be used to refine the search.

Find Next

If you have defined the Find criteria within the Find dialog, then this option will repeat the search using the
same criteria.

Find Category ...

You can also search by category be selecting Find Category ... option, which brings up the Find Category
Dialog.

Find Next Category

If you have defined the Find Category criteria within the Find Category dialog, then this option will repeat the
search using the same criteria.

Goto ...

Selecting this option brings up the Goto Dialog, which allows you to quickly navigate to a numbered Object.

The kronos.factory Window 12



The View Menu

The View menu provides the following options:

v Tool Bar + Tool Bar v Tool Bar

v/ Status Bar + Status Bar v/ Status Bar

v No Split No Split No Split
Horizontal Split v Horizontal Split Horizontal Split
Vertical Split Vertical Split Vv Vertical Split

v Tree Left Pane > Left Pane »>
Table Right Pane > Right Pane >
Refresh Refresh Refresh

Note how some of the options change depending on whether or not the Child Window is split.

When the Child Window is split the Left/Top Pane and Right/Bottom Pane menu options have the following
sub menu.

v Tool Bar
v Status Bar

No Split
v Harizontal Split
Vertical Split

Right Pane »> Table

Refresh
Tool Bar
When checked the kronos.factory Tool Bar is visible.
Status Bar
When checked the kronos.factory Status Bar is visible.
No Split
When checked the current Child Window is not split.
Horizontal Split
When checked the current Child Window is split horizontally.
Vertical Split
When checked the current Child Window is split vertically.
Tree
When checked the main/left/top pane in a Child Window displays data in a Tree View.
Table
When checked the main/right/bottom pane in a Child Window displays data in a Table View.
Refresh
Refreshes all open Child Windows.
This command is provided in case the screen is not properly updated following an edit operation. There are a
couple of odd bugs | cannot track down on screen updates. So if you come across them as well, then this
command will force a redraw of the windows.
Preferences ...

This menu option is not available if the host operating system is OS X. On OSX there is a Preferences...
menu option in the kronos.factory Application Menu.

Opens the kronos.factory Preferences Dialog.

The kronos.factory Window 13



The Window Menu
The Window menu provides the following options:

Tile Horizontal
Tile Vertical LBV

Maximise Windows M
Restore Windows HR
Minimise Windows 381

Carreg Ddu.PCG
Welsh Floyd.PCG

In the example given above, you'll see that after the predefined menu options there are menu options that
allow you to select the windows currently open within kronos.factory (Carreg Ddu.PCG an Welsh Floyd.PCG
in our example menu).

Tile Horizontal

Arranges all non-minimised Child Windows along the horizontal axis.

Tile Vertical

Arranges all non-minimised Child Windows along the vertical axis.

Maximise Windows

Maximises all Child Windows so that they all occupy the size defined by the desktop.

Restore Windows

Restores all maximised/minimised Child Windows to their normal state.

Minimise Windows

Reduces all Child Windows to their iconised state.

The kronos.factory Window
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The Help Menu

The Help menu provides the following options (OS X and Windows versions are shown):

[E Get Help on kronos.factory ...
@ View Tips and Tricks for kronos.factory ...

View PDF Documentation for kronos.factory ...
View License Agreement for kronos.factory ...
Get Support for kronos.factory ...

Register and Activate kronos.factory ...

Search

OS X only. This is a standard OS X Menu function currently not working with kronos.factory. One day....

Get Help on kronos.factory ...

[l Get Help on krones.factory ...
@ WView Tips and Tricks for kronos.factory ...

View PDF Documentation for kronos.factory ...
View License Agreement for kronos.factory ...
Get Support for kronos.factory ...

P About kronos factory ..

Register and Activate kronos.factory ...

Displays the kronos.factory Online Help system.

View Tips and Tricks for kronos.factory ...

Displays the kronos.factory Tips and Tricks Dialog.

View PDF Documentation for kronos.factory ...

Displays the PDF documentation for kronos.factory. Note that there needs to be a registered viewer for PDF

files on your system for this command to work

View License Agreement for kronos.factory ...

Displays the kronos.factory License Agreement in a dialog box.

View License Agreement for kronos.factory ...

Provides a link to the x.Librarian's Support Page.

About kronos.factory ...

This menu option is not available if the host operating system is OS X. On OSX there is an About

kronos.factory menu option in the kronos.factory Application Menu.

Displays the kronos.factory About Dialog, which provides some basic information about the program, such as

the version number.

Register and Activate kronos.factory ...

Displays the kronos.factory registration and activation Dialog.

See the Registration Section for details of how to register kronos.factory.

The kronos.factory Window
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Tool Bar
The Tool Bar contains buttons for common operations, such as opening and saving files.

Displays the New File Dialog to allow you to select the type of file to create

Displays the Open File Dialog to allow you to select a file to open

Saves the currently selected file

Displays the Save As Dialog to allow you to select a different name for the currently selected file

Saves all the open files to disk

Cuts the selected Objects and places them on the Clipboard

Copies the selected Objects and places them on the Clipboard

Pastes the contents of the Clipboard to the current selection. If you cannot perform a paste at this location
gz.g. trying to copy a Set List onto a Program) then this menu item is disabled

Undos the previous edit

Redos the previous edit

Displays the Eind Dialog to allow you to define the search criteria and then search for the first occurence
Searches for the next occurence of the search criteria defined in the Eind Dialog

Displays the Preferences dialog where you can configure kronos.factory

Displays the kronos.factory Online Help index page

Enables Context Sensitive Help

Displays the Tips and Tricks Dialog
Displays the About Dialog

BESEXAEEDL D

CeIEIBE@

The Save buttons are only enabled if kronos.factory is Registered.

If the SHIFT key is held down when clicking on the # (Find) button, then the Eind Category Dialog is
displayed instead.

If the SHIFT key is held down when clicking on the ® (Find Next) button, then a Find Category search is
performed instead.

The Tool Bar can be dragged and made a floating toolbar by clicking and dragging the handle to the left of the
Tool Bar.

The Tool Bar can also be dragged to a different window border other than the top border.
The Tool Bar can be hidden/unhidden by the Tool Bar menu option on the View menu.

The Tool Bar whilst floating can be docked once more by closing it.

The kronos.factory Window 16



Desktop

The Desktop portion of the window is where the Kronos data is portrayed. Several files may be opened and
shown within Child Windows upon the Desktop portion of the window. The following example shows
three Child Windows open on the Desktop.

Welsh Floyd.PCG

* 5 Combi Banks Mumber Category Sub Category Mame
v B& U-D 014 LeadSynth Hard Shine On Lead
5 S : 015 LeadSynth Hard Shine On Sparkle
¥l 00U} Shine Oniintro/ (Finke g eise ) 016 Sowsynth  [Bright Deep Asleep Squares
» [ Effects 017 Organ Drawbar Control  [Shine On Upper
Vector Control 018 Organ_ __|Drawbar Control  [Shine On Lower |
Contraller 019 Organ Drawbar Control Learning To Fly Organ
Audig Inputs gg? gotionfwnth .Eﬂmm: c | I‘_:ea.rpingET t:kFI.IY S\Lv:!e eg
. rgan \Drawbar Control oming Back To Li rg
= Drum Track'ikgno: om 022 LeadSynth |Hard Wish You Were Here |
b [0 KARMA 023 Organ Drawbar Control  |Hey You Organ
Common 024 slowsynth IDark Hey You Poly
Assignable Controllers 025 FastSynth Short Release Another Brick Bass
v & Timbres 026 SlowSynth Sweep Another Brick BPF Sweep
D1 INT: U-AA 014 : Shine On Lead (LeadSynth.Hard) (CH: Gbl) 'gg; E'"" Floyd _gserg e :F"?::EEEL!(.E E.f%d. N
rgan rawbar Control nother Bric rgan
02 INT: U-E 015 : SH FREEZE (Organ.Drawbar Control) (CH: Gbl) 029 ngk Floyd User 0 'B g
S e e 71 D30 |MotienSynth  |Motion On The Run

@0 e Carreg Ddu.PCG LN ] KRS-79.PCG
=5 Kronos Synth Model Number Category Sub Category MName

MotinSynth Motion Arpeggiater Pad
MotionSynth Rhythmic KApro E-Motion Touch 1
Y B8 Program Banks MationSynth Motion KApro E-Motion Touch 2
¥ S -A(EXD MotionSynth Motion  |KApro E-Motion Touch 3 |
» 7 000 : KROMOS German Grand (Keyboard.A.Fiano) MeotionSynth Motion Wallop Modeling 1
[ 001 : German Dark Grand (Keyboard.A.Piano) MOUOHSE"N: Motion Wallop MOEE““Q 2|
[ 002 : R.Ferrante German Grand (Keyboard.A.Piano) MotionSynt Mogion_ KApro AIDERETDATE
[ 003 : German New Age Grand (Keyboard.A.Pianc) MotlonSynth ___Rhythmic Zero To Hero Motions |

MotionSynth Motion KApro Trance Pad
|7 004 : L.Mays German Grand (Keyboard.A. Piang) SlowSynth Dark Dark Chill Pad

|9 005 : German Grand + WPM (Keyboard.A.Piano) FastSynth Long Release KApro Sweeping Synh

> [ Set Lists

The Window Menu provides menu options to:

¢ Tile (either vertically or horizontally) all Child Windows that are not iconised
* Minimise all Child Windows

* Maximise all Child Windows

* Restore all Child Windows

¢ Select a specific Child Window

When a file is opened, a Child Window is added to the Desktop Area.
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Child Window

The Child Window provides the View upon the data within the file it is associated with.

The Child Window is maximised by default when it is opened, and can be minimised, restored or closed by the
buttons to the right of the Child Window's title bar.

The menu options on the View menu can be used to change the View between a Tree view and a Table view,
and a Child Window can be either split horizontally or vertically split to show any of the following

combinations:

o A Tree and a Table
e A Table and a Tree

e Two Trees
e Two Tables

The default Child Window View applied when a file is opened is set in the Default View Tab of the Preferences

Dialog.

The following example shows a Child Window that is split and showing both a Tree View and a Table View on

the same data.

-

Welsh Floyd.PCG

>

¥y ¥ ¥ ¥ Y Y Y Y vy v v vy vy vy vy vy wvyy

| 000

| 001

| 002

| 003

| 004

| 005

| 006

| 007

| 008

| 009

1010

011

| 012

| 013

| 014

| 015

1016

017

|018

= Kronos Synth Model
» [ 7 Set Lists
¥ [ Program Banks
v [ U-AdCEXD
: The Voice Pad (SlowSynth.Bright)
: Ultravox Lead (LeadSynth.Soft)
© S¥YN Drum (Drums.Perc)
: Fade to Grey Bass Synth (Bass/Synth Bass.Synth Ba
: Fade To Grey Plucked (LeadSynth.Soft)
: Fade To Grey Bright 1 (FastSynth.Short Release)
: Fade To Grey Bright 2 (FastSynth.Short Release)
: Fade To Grey Lead (LeadSynth.Soft)
: Mad World Bass (Bass/Synth Bass.Synth Bass)
: Mad World Pulse (FastSynth.Long Release)
: Mad World Marimba (Bell/Mallet.Mallet)
. AFE Synth (Bass/Synth Bass.Synth Bass)
: AFE Vox Humana (FastSynth.Short Release)
: Shine On (Pink Floyd.User 0)
: Shine On Lead (LeadSynth.Hard)
: Shine On Sparkle (LeadSynth.Hard)
: Deep Asleep Sguares (SlowSynth.Bright)
: Shine On Upper (Organ.Drawbar Control)
: Shine On Lower (Organ.Drawbar Control)

Mumb... Category Sub Category Mame

000 SlowSynth Bright The Voice Pad

001 LeadSynth soft Ultravox Lead

002 Drums Perc SYN Drum

003 Bass/Synth Bass |Synth Bass Fade to Grey Bass Synth
004  |LeadSynth soft Fade To Grey Plucked
005 FastSynth Short Release Fade To Grey Bright 1
006 FastSynth Short Release Fade To Grey Bright 2
007 LeadSynth Soft Fade To Grey Lead

008 Bass/Synth Bass |Synth Bass Mad World Bass

009  |FastSynth Long Release Mad World Pulse

010 Bell/Mallet Mallet Mad World Marimba
011 Bass/Synth Bass |Synth Bass AFE Synth

012 FastSynth Short Release AFE Vox Humana

013 Pink Floyd User 0 Shine On

014 LeadSynth Hard Shine On Lead

015 LeadSynth Hard Shine On Sparkle

016 Slowsynth Bright Deep Asleep Squares
017 Organ Drawbar Control  |Shine On Upper

018 Organ Drawbar Control  |Shine On Lower

019 Organ Drawbar Control |Learning To Fly Organ
020 MationSynth Motion Learning To Fly Sweep
021 Organ Drawbar Control |Coming Back To Life Org
022 LeadSynth Hard Wish You Were Here
023 Organ Drawbar Control  |Hey You Organ

024 SlowSynth Dark Hey You Poly

025 FastSynth Short Release Another Brick Bass

026 SlowSynth Sweep Another Brick BPF Sweep

The Tree and Table views support drag move and drag copy operations, and the views will automatically

scroll whilst drag operations are in progress.

Note that if you have enabled the Miscellan Preferences to load Sample and KARMA files (if they are
present) then these are show, but they are rendered differently in red text and yellow background as shown
below. The reason for this is that this data cannot be edited in this version of kronos.factory. It is loaded to
provide information for other data in the file. For example, to provide Sample names for what samples the
HD-1 Program Oscillators are referring to. Editing will be introduced in future versions for user sample data.

The kronos.factory Window
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[ NN kronos.factory - Korg Kronos Librarian
IIFEIEIEEIENEIE R IEREN BRI

[ NON | Carreg Ddu.PCG (3.x PCG File)
[ Kronos Synth Model ata)
» [ set Lists Set Lists

Program Banks
Combi Banks
Wave Seguence Banks

» || Program Banks
» [ Combi Banks

» |7 Wave Sequence Banks Drum Kit Banks
» [ Drum Kit Banks Drum Patterns
» [ Drum Patterns Global Settings (781519)

Sample Banks

Global Settings (781519) KARMA User Data

» [0 Sample Banks
>[I KARMA User Data

| /Developm... [PCG ... |[Modi... | | | | | |All D... |

The kronos.factory Window



Tree View

The Tree View shows the PCG data as a hierarchical tree, and can show more information than the Table
View. The following example shows a split Child Window with two Tree Views, one collapsed showing the top
level Collections, including all the available Program Banks, and one showing a Program (U-AA 0007) that
has been expanded to show more information on the Program.

[ JON Welsh Floyd.PCG
Kronos Synth Model v U-Ad (EXT)
» 2 Set Lists » [ 000 : The Voice Pad (SlowSynth.Bright)
v Program Banks » [ 001 : Ulravox Lead (LeadSynth.5oft)
L I-AC(EXD b 1002 :5YN Drum (Drums.Perc)
» |7 1-B (HD-1) » | 1003 : Fade to Grey Bass Synth (Bass/Synth Bass.Synth Bass)
» B I-C (HD-1) » 1004 :Fade To Grey Plucked (LeadSynth.Soft)
» [ 71-D (HD-1) » 71005 :Fade To Grey Bright 1 (FastSynth.Short Release)
» [ I-E (HD-1) » 71006 :Fade To Grey Bright 2 (FastSynth.Short Release)
» [ |I-F(HD-1) v 007 : Fade To Grey Lead (LeadSynth.Soft)
b [T U-A (HD-1) v Effects
b 7 U-B (EXI) b | Insert Effects
T U-C (EXI) v Master Effects
» [ U-D (EXD Master Effect 1: No Effect
» [ U-E (EXD Master Effect 2: O-verb
» [ U-F (EXD v Total Effects
» [ U-G (HD-1) Total Effect 1: No Effect
b ] U-AA (EXD) Total Effect 2: No Effect
» [ U-BB (HD-1) » Effect LFOs
» [0 U-CC (EXD Effect LFO 1
» B U-DD (HD-1) Effect LFO 2
» I8 U-EE (EXD) Wector Control
b |7 U-FF (EXI) Controller
» || U-GG (HD-1) Audio Inputs
» [ Combi Banks Drum Track (PO00: Off)
» [ wave Sequence Banks v ICARMA
» |7 Drum Kit Banks KARMA Module - 0000: Arp Model 01 Up/Dn
» || Drum Patterns Banks Common
Global Settings Assignable Controllers
v EXI Program Oscillators
EXI Program Oscillator: AL-1
EXI Program Oscillator: OFF
| 008 : Mad World Bass (Bass/Synth Bass.Synth Bass)
» 1009 : Mad World Pulse (FastSynth.Long Release)
b | 1010 : Mad World Marimba (Bell/Mallet.Mallet)

Basically, information is shown as a set of hierarchical Objects. Objects may have children attached to them,
and they themselves may have further child Objects (e.g. a Combi Object, has a child Object for all of its
Timbres, and this Object groups all the Timbres).

The basic tree structure is a Root Object at the top of the tree under which are various Object Collections
which themselves contain further data. The top level Collections that can be found under the root node varies
upon the file contents
Objects are displayed in one of three colours:

¢ Black if the Object is not referenced by another Object

¢ Blue if an Object is referenced by another Object (e.g. a Voice being used within a Performance, or a

Sample being used by a Wave)
¢ Red if the Object is a Sample and it is "empty"

The Tree View allows multiple Objects to be selected, which is useful for performing operations only upon
certain Objects. You can only perform operations upon Objects of the same type.

If you wish to perform an operation upon all Objects in a Collection, simply select the Collection containing the
Objects.

If you right click over an object or selection of objects within the Tree View, a context sensitive popup menu
will appear that provides the editing operations that can be performed upon the object(s).

Objects can be Copied and Moved either within or between Child Window Views using Drag and Drop.
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Table

View

The Table View provides a more high level overview of the data than the Tree View, and the representation of

the data is more compact. The following example shows a Child Window with a single Table View providing
information on a file's Programs in one of the Program Banks.

[ JON ] Welsh Floyd.PCG

Mumber Category Sub Category Name

000 SlowSynth Bright The Voice Pad

001 LeadSynth Soft Ultravox Lead

002 Drums Perc SYN Drum

003 Bass/Synth Bass Synth Bass Fade to Grey Bass Synth
004 LeadSynth Soft Fade To Grey Plucked
005 FastSynth Short Release Fade To Grey Bright 1
006 Fastsynth Short Release Fade To Grey Bright 2
007 LeadSynth Soft Fade To Grey Lead
008 Bass/Synth Bass Synth Bass Mad World Bass

009 Fastsynth Long Release Mad World Pulse

010 Bell/Mallet Mallet Mad World Marimba
011 Bass/Synth Bass Synth Bass AFE Synth

012 FastSynth Short Release AFE Vox Humana

013 Pink Floyd User 0 Shine On

014 LeadSynth Hard Shine On Lead

015 LeadSynth Hard Shine On Sparkle

016 SlowSynth Bright Deep Asleep Squares
017 Organ Drawbar Control Shine On Upper A

The Table View can only show one Collection of Objects at a time.

Each row within the table shows one Object.

Objects can be Copied and Moved either within or between Child Window Views using Drag and Drop.

If you right click over an object or selection of objects within the Table View, a context sensitive popup menu
will appear that provides the editing operations that can be performed upon the object(s). The cells in a Row
that contain the Object Category and Object Name (if available) can be directly edited by clicking in them.

The context menu also provides the options to select what data view. In the example below, the table is

currently showing the INT Wave Sequence Bank, but a selection is being made via the menu to change to the
U-A Bank.

You can also double click a high level collection (e.g. Program Bank Collection, Program Banks) and
kronos.factory will move down to the next level until you get to discrete objects (e.g. Program). You can
double click with the ALT key (OPTION key on OS X) held down to traverse upwards.

The kronos.factory Window

21



1 (3.x PCG File)

Mumber Name

000 19 Orch/Band HITS

001 Ac.Guitar Rhythm 01

002 Air Rotation

003 Al e e

004 Initialise

005 Insert

105 Delete

007

008 Sort by Name

009

010 List References ...

011

012 Cut

013

014 Copy

015 Paste

016 Show All Data Banks

017 Show Programs >

018 Show Combis >

013 R =T  Wave Seq Banks

gg? Show Drum Kits > Wave Seq Bank INT

022 Show Drum Patterns Wave Seq Bank U-A

023 Show Set Lists Wave Seq Bank U-B

024 Crunch Wave Seq Bank U-C

ggg gWGS Clavs Wave Seq Bank U-D
rops

027 E.Fiapno Klik Selection g::: ::q Ea"t H:E

028 EP SEQ q ban

079 Eiohe Wave Seq Bank U-G

030 Evolving 01 Wave Seq Bank U-AA

031 Exposure Wave Seq Bank U-BB

g:: E:i::"sig Wave Seq Bank U-CC

034 e Wave Seq Bank U-DD

035 Cate Rez Wave Seq Bank U-EE

036 Glass-Air Wave Seq Bank U-FF

037 Groove Wave Seq Bank U-GG

038 Jordan's Bop

039 L Strings Octave

040 Lob Wave

The kronos.factory Window
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Status Bar

] /Development/Kronos /Welsh Floyd/Welsh FI...[ PCG File Modified [ [ I [ All Data Banks [ Combi Bank |

The Status Bar provides the following pieces of information (from left to right) for the Child Window which is
currently selected:

e The name of the file currently open, if any. If no file has been selected then this field is blank

¢ The type of the file

e Whether or not the file has been modified

¢ If the left/top split pane is a table this indicator identifies what the table is showing (Programs, Combis,
etc.)

o [f the right/bottom split pane is a table this indicator identifies what the table is showing (Programs,
Combis, etc.)
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kronos.factory Program Features

kronos.factory provides the following features:

e File Operations

e Undo/Redo Support

¢ Clipboard Support

¢ Find and Goto Support
¢ Editing Features

kronos.factory Program Features
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File Operations

kronos.factory supports the following file operations:

e Create New Files

¢ Open Existing Files
e Save Files

¢ Open and Save Workspaces
e Export Data

kronos.factory Program Features
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Create New File

When the New File ... option from the File Menu or the [ button on the Toolbar is selected, the following
dialog is shown:

] kranos.factory New PCG File (3.x) Options
Program Banks Combination Banks
0K
I-A I-B I-C 1-D I-E I-F I-A I-B I-C 1-D I-E I-F I1-G
U-A U-B u-c u-D U-E U-F U-G U-A U-g u-c U-o U-E U-F u-G Canc

Bu-aan Bu-ee Bucc Huop G@u-ee Bu-FF B UGG

__All _Nane _ AL Mone
Drrumk Kit Banks Wave Sequence Banks Al
Int Int

Non
U-A U-B u-c u-p U-E u-F u-G u-A u-B u-c u-p U-E U-F u-G

U-AA U-BE u-cc u-po U-EE U-FF uU-cc U-Aa U-BB u-cc u-ob U-EE U-FF u-ca

All Mone All Mone
Other Settings Information
Clobal Settings kronos.factory currently only supports the creation of V3.x files.

Drum Track Patterns

Set Lists

This dialog, which is modelled on the Kronos file save options, allows you to select the banks which are
created from the following

® Programs

¢ Combis

¢ Drum Kits

e Wave Sequence

¢ Global Settings

e Drum Track Patterns
e Set Lists

The new data file is given a name in the form of "kronosFactory_n", where n is a number that increments
every time a file is created.

Note, this is different from initialising data in a file, as a totally new file is created.

Note, only the creation of 3.x file formats is supported in this release of kronos.factory. If there is sufficient
demand, | may add support for the creation of earlier, legacy PCG file formats.
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Open Existing File

When the Open ... option from the File menu or the =8 button on the Toolbar is selected, the following dialog
will appear allowing a file to be selected.

@ [ ] krones.factory - Select the file to open
| Spectral Streams E
Name ~  Date Modified
_| Spectral Streams Thursday, 13 December 2018 12:29
i Spectral Streams.PCG Wednesday, 4 April 2018 11:57
File Format: = Kronos Files (PCG) a
Cancel Open

Only PCG files are currently supported for loading.

kronos.factory checks to ensure that the selected file is a valid Kronos format file, and an error dialog will
appear if the file is not valid.

If the file you are trying to open is an OASYS PCG file, then the following error dialog will be shown, as
OASYS files are currently not supported (their file structure is different again). If there is sufficient demand, |

may support the import of OASYS files in later releases. In the meantime, you can load them in your Kronos
and save them out as Kronos PCG files.

@ kronos.factory

] EXI_XP.PCG: Is an OASYS PCG File, which are not currently supported.

3 These may be supported in a later release

0K

If a file selected for opening is already open, kronos.factory will ask if you want to replace the file that is in
memory.
No other PCG files (i.e. for other synth types) are supported.
Loading KSC Files

kronos.factory will also try and load a corresponding Sample (KSC) file if one is present in the same directory
as the file you are loading.

Currently KGE and KSC data cannot be edited. This will be supported in a future release. Song files may also
be supported in a future release.

The loading of Samples can be controlled by the setting of the Sample Load Options drop down in the Misc
Preferences tab in the Preferences Dialog.

If this option is set to Confirm, then the following dialog is displayed:
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[ ] kronos.factory

. Load Samples from "/Development/Kronos/Welsh Floyd /Welsh Floyd.KSC"?

No | |
If the Sample Load Options setting is set to Yes, then the samples are automatically loaded, and if the
Sample Load Options is set to No, then the samples are not loaded.
Loading KGE Files

kronos.factory will also try and load the corresponding KARMA Generated Effect (KGE) file if one is present in
the same directory as the file you are loading.

Currently KGE and KSC data cannot be edited. This will be supported in a future release. Song files may also
be supported in a future release.

The loading of KGE files can be controlled by the setting of the KARMA Load Options drop down in the Misc
Preferences tab in the Preferences Dialog.

If this option is set to Confirm, then the following dialog is displayed:

@ kronos.factory

L B Load KARMA data from "/Development/Kronos/Welsh Floyd/Welsh Floyd.KGE"?

L=

No | |

If the KARMA Load Options setting is set to Yes, then the KGE file is automatically loaded, and if the
KARMA Load Options is set to No, then the KGE file is not loaded.
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Save Open Files

The saving of files is only available if kronos.factory is reqistered.

When you save a file to disk using: the Save As ... command from the Eile Menu, or when a file created using
the New ... command from the File Menu is saved for the first time, the following dialog appears to allow you
to select a name for the file.

@ [ ] kronos.factory - Select the file to save to

Save As: Welsh Floyd.PCC

[[7) Welsh Floyd <]
Nama ~  Date Modified
| Welsh Floyd Saturday, 18 November 2017 15:38
[ |
=
File Format: = Kronos Files (PCQ) E
New Folder Cancel | Save |
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Workspaces

kronos.factory allows you to save the current size and position of the main kronos.factory window, and the
arrangement of the open Child Windows within kronos.factory to a file known as a Workspace.

This allows you to save a Workspace you are using for future recall at a later date.
The following parameters for each Child Window are remembered:

¢ Window size, position and status (normal, maximised or minimised)
e Horizontal/Vertical Splits, including split position

e Pane type(s) (e.g. Tree, Voice Table or Performance Table)

¢ Tree node expansion status

e Table column widths

¢ Scroll position of the pane(s)

e Selection state of the tree nodes, or table rows
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Undo Buffer

kronos.factory supports a multi-level Undo/Redo Buffer facility on all edits.

The number of edits which can be stored is 100.

The Undo/Redo commands can be found both within the Edit Menu, and on the Toolbar.

Please note that the undo buffer is global across all open files, and is cleared when any file is closed. This
may be improved in later releases.

The undo buffer can be cleared by the selecting the Clear Undo Buffer option on the Edit Menu. The
intention of this feature is to help cope with low memory situations, as it will free up the memory used by
stored edits.

kronos.factory Program Features

31



Clipboard Support

The clipboard works just like the clipboard in other applications. It allows you to place an Object or a copy of
an Object upon the clipboard and then paste that Object elsewhere within a file or another file.

You can Cut/Copy either a single Object or a Collection of Objects onto the clipboard.
You can only paste from the clipboard to the current location in a file if it makes sense to do so. For example:
¢ You cannot paste a Program onto a Combi

¢ You cannot paste ten Programs at the end of a Program Collection if the selection is at Program 118
or higher

The clipboard is "local" to the application, and only Objects can be placed upon it.

kronos.factory does not support the system clipboard so it is not possible to cut and paste between and other

applications. | don't think this is a major drawback because | cannot think of any circumstances where you
would wish to do this!
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Find and Goto Facilities
Find Dialog

kronos.factory supports the ability to find Objects either by name or by category (where an Object supports
categories, such as Voices).

Searches start from the currently selected Object.

Selecting the Find ... option on the Edit Menu brings up the Find dialog, that allows you to specify the string to
search for. In addition there are several options that can be selected

Q Find
Find What |
Match Case

Match Whole Name

Use Wildcards

Ok Cancel
Find What The text string to search for.
Match Case If this option is checked then the search is case sensitive. If this option is not checked then

the search is case insensitive.

Match Whole If this option is checked then the search string must match the entire name of an Object.
Name E.g. "pan” would match a Voice called "pan”, but not a Voice called "pandora”. If this option
is not checked then the search can match a sub string within a name. E.g. "dor" would
match a Voice named "dor" and a Voice called "pandora”.

Use Wild Cards [If checked kronos.factory will treat the "Find What" text as a "regular expression” to allow
you more control over the search, such as matching text at the start of a name, or the end
of a name, words with numbers in, etc.

The regular expression language used for kronos.factory wild card support is the Perl Regular Expression
Syntax. Rather than try and write up this powerful syntax myself into the kronos.factory documents, I'll direct
you to the Perl Regular Expression Syntax page for a description of how to use this powerful feature.

Find Category Dialog

You can also search by category be selecting Find Category ... option on the Edit Menu, which brings up the
Find Category Dialog.

This option allows you to search, for example, for all string Voices in a file (assuming all Voices have been
assigned a category). Note: only some Objects (such as Voices and Performances) have a category value.

[ ] Find

Find Category Keyboard a

Ok Cancel

Simply select the Category from the "Find Category" combo box that you wish to search for, and that's all
there is to it.
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Goto Dialog

Selecting this option on the on the Edit Menu brings up the Goto Dialog

@

Goto

Item Type | program Bank I-A (EXI) [ T

Item Number

Ok

ofl>

Cancel

Item Type

The type of Object to go to

¢ The list of types of Objects that can be selected depends upon the contents of
the file.

e If a Table View is selected then you can only go the type of objects shown by the
Table

ltem Number

The number of the Object to go to.
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Editing Features

kronos.factory supports the following editing features:

e General Editing Features
e Synth Editing Features
e Set List Editing Features

* Program Editing Features
¢ Combi Editing Features

Drum

Kit Editing Features

rum

Pattern Editing Features

* Wave Sequence Editing Features
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General Editing Features

kronos.factory supports many editing features, some of which are classed as general features that are
applicable to all or most Objects.

The general features are described here in one place for convenience:

* Copy/Move Object
« |nitialise Object

¢ Rename Object

* Insert Object

¢ Delete Object

o List Object References
* Sort Objects

¢ Export Objects

e Rema _Ob'ects

e Add Objects to Library (note this will be added in a later version)

kronos.factory Program Features

36



Copy/Move Object
kronos.factory makes extensive use of drag and drop for copying and moving Objects.

You can drag copy or move Objects within a file or between files, and you can drag single items or multiple
items.

The default drag operation is to move an Object, and there are two types of move operations:

* Moving an Object within its Parent Collection (e.g. moving a Program from location 1 to location 4)
¢ Moving an Object to a new Parent Collection (e.g. moving a Program from one file to another file)

When you move an Object to a new Parent Collection then the original Object is removed and replaced with
an initialised Object of the same type.

To copy an Object using drag and drop, you must have the DRAG MODIFIER key held down during the
operation. The DRAG MODIFIER key is platform dependent. On the PC platform it is the CTRL key.

You can tell that a copy operation is in progress as the drag image icon has a + sign visible.

When you drag multiple items they must be of the same type. For example you can drag several Programs,
but not Programs and Combis together.

kronos.factory provides the following drag/drop feedback to assist in determining the effects of a drag/drop
operation:

e Cursor: Indicates if the move is either a copy or a move, or if the drop is invalid (e.g. trying to drag a
Program onto a Wave Sequence)

e Drag image: A simple pictorial representation of what is being dragged

» Drop Point: kronos.factory shows the drop point as either a cue line drawn between Objects if an
Object is being moved within its parent (e.g. a Timbre within a Combi), or a cue rectangle drawn
around the drop location for all other moves and copy operations which are valid

When a Child Window is split, Objects can be dragged and dropped between either side of the split point. This
is handy, for example, for dragging Objects between the start of a Collection and the end of a Collection.

The Tree and Table views will auto-scroll in drag and drop operations, when you move the cursor to either the
top or the bottom of the pane and hold it there.

If you drag an Object onto a Tree View and over a valid parent Object (e.g. a Timbre over a Combi) and the
parent Object is collapsed within the Tree, and you hold the cursor over the Parent Object for a few seconds it
will automatically expand.

kronos.factory will maintain the references to Objects in a Collection when moving Objects within a file, as
follows:

Collection Type [Objects Updated
Combi Set List Slots
Program Set List Slots
Combi Timbres
Drumkit HD-1 Program Oscillator Trigger Zones
Drum Pattern Programs
Combis
Wave Sequence [HD-1 Program Oscillator Trigger Zones

For example if you move a Program within a PCG file Program Bank from Location 2 to Location 10, then any
Combi Timbres which are referencing Programs at Locations 2 and above will be updated to ensure they still
reference the same Programs after the move operation as they were before the move operation.

The ability to update references following a move or to copy referenced Objects during a move to a new file
can be selectively turned on or off within the Preferences Dialog.

Initialise Object
Initialises the selected Object to its default state.
Multiple Objects of the same type can be selected for initialisation.

The Initialise command is found upon the Context Sensitive Menu in both the Tree View and the Table
View.

Rename Object

Renames the selected Object using the following dialog:
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[ ] Rename EXI| Program

EX| Program Mame

oK
Shine On Lead LeadSynth B [ Had B

Cancel

Only one Object can be selected for renaming.

The dialog will provide drop down lists for selecting a Category and Sub Category values for Objects that
support it:

Object Type Category?
Set List Slot No

Program Yes
Combi Yes
Drum Kit No

Drum Pattern No
Wave Sequence [No
The Rename command is found upon the Context Sensitive Menu in the Tree View

To rename Objects in the Table View, simply click in Category Cell of the required Object to select the

Category value from a drop down list, or double click in the Name Cell of the required Object to edit the name.

Insert Object

Inserts an Object into a Collection at the current location.

The Insert command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

You can insert more than one Object at a time by selecting multiple Objects prior to executing the Insert
command.

For example if you wish to insert three Combis at location 10, select Performances 10, 11 and 12 and then
execute the Insert command.

Note that when you insert one or more Objects, then the commensurate number of Objects at the end of the
Parent Collection are removed if required. This is necessary to maintain the correct number of Objects in a
Collection.

For example, a Combi Branch Collection in a PCG file can only contain 128 Combis, so if two Combis are
inserted into the Collection then two Combis must be removed from the end of the Collection to maintain the
correct size.

kronos.factory will maintain the references to Objects in a Collection when inserting Objects, as follows:
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Collection Type

Objects Updated

Combi

Set List Slots

Program Set List Slots
Combi Timbres
Drumkit HD-1 Program Oscillator Trigger Zones

Drum Pattern

Programs
Combis

Wave Sequence

HD-1 Program Oscillator Trigger Zones

For example if you insert a Program into a PCG file Program Bank at Location 10, then any Combi Timbres
which are referencing Programs in the bank at Locations 10 and above will be updated to ensure they still
reference the same Programs after the insert operation as they were before the insert operation.

Delete Object

Deletes an Object at the current location.

The Delete command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

You can delete more than one Object at a time by selecting multiple Objects prior to executing the Delete
command.

For example if you wish to delete three Combis at location 10, select Performances 10, 11 and 12 and then
execute the Delete command.

Note that when you delete one or more Objects, then a commensurate number of Objects at the end of the
Parent Collection are added if required. This is necessary to maintain the correct number of Objects in a
Collection.

For example, a Program Bank Collection in a PCG file must contain 128 Voices, so if two Programs are
deleted from the Collection then two Programs must be added to the end of the Collection to maintain the
correct size.

kronos.factory will maintain the references to Objects in a Collection when deleting Objects, as follows:

Collection Type |Objects Updated

Combi Set List Slots
Program Set List Slots
Combi Timbres
Drumkit HD-1 Program Oscillator Trigger Zones
Drum Pattern Programs
Combis

Wave Sequence [HD-1 Program Oscillator Trigger Zones
For example if you delete a Program from a PCG Program Bank at Location 10, then any Combi Timbres
which are referencing Programs in that Bank at Locations 10 and above will be updated to ensure they still
reference the same Programs after the delete operation as they were before the delete operation.

List Object References

The List References command is found upon the Context Sensitive Menu in both the Tree View and
the Table View.

The List References command is only available if:

¢ Only one Object is selected
¢ The Object selected is referenced by another Object, which is indicated by the Object being coloured
blue

The references are shown as follows:

[ JON List References
EXI Program U-AA (EXI) 014: "Shine On Lead" is referenced by
Combi U-D “000 : Shine On Intro (Pink Floyd.User 0)", Timbre: 01
Combi U-D "001 : Shine On Organs (Pink Floyd.User 0)", Timbre: 03
Combi U-D "002 : Shine On Solo (Pink Floyd.User 0)", Timbre: 03
Combi U-D "003 : Shine On Ending (Pink Floyd User 0)", Timbre: 01

The Object being referenced is shown at the top of the Dialog followed by the Objects referencing it.
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Sort Objects
The Sort command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

The type of sort operations available depend upon the types of Object being sorted:

Object Type Sort by Name |Sort By Category
Set Lists Yes No

Set Lists Slots Yes No

Programs Yes Yes

Combis Yes Yes

Drum Kits Yes No

Drum Patterns Yes No

Wave Sequences [Yes No

In the Tree View the sort options are accessed via the Context Sensitive Menu for the Collection that you
wish to sort (e.g. a Program Bank Collection to sort Programs).

In the Table View the sort options are accessed via the Context Sensitive Menu for any Object. The sort can
also be initiated by clicking in the Category or Name column headers.

Synth Editing Features

kronos.factory supports the following editing operations upon the Synth Object within the Tree View of
a Child Window:

e Move

e Copy

e Initialise

¢ Add - If not all main collections are present in the file (e.g. Program Banks, Combi Banks, etc.) then
this menu will be present allowing you to add in the items that are not present

e Cut to Clipboard

* Copy to Clipboard

e Paste from Clipboard

To access these features, right click over the Synth Object to activate the Synth Object's Context Sensitive
Menu.

The Synth Object is only shown within a Tree View and is the first Object in the Tree View.
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Set List Editing Features
Set List Collection Editing Features

kronos.factory supports the following editing operations upon the Set List Bank Collection shown within
the Tree View or Table View of a Child Window:

e Copy/Move
o |nitialise

e Delete
e Sort by Name

e Cut to Clipboard

® Copy to Clipboard

e Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the Set
List Collection to activate the Set List Collection's Context Sensitive Menu.

Set List Editing Features

kronos.factory supports the following editing operations upon the Set Lists shown within the Tree View
or Table View of a Child Window:

e Copy/Move

o |nitialise

e Delete

e Sort by Name

e Cut to Clipboard

. lipboard

¢ Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the Set
List Collection to activate the Set List Collection’'s Context Sensitive Menu.

Set List Slot Editing Features

kronos.factory supports the following editing operations upon the Set List Slot Objects within the Tree View
or Table View of a Child Window:

e Copy/Move

o |nitialise

e Rename

e Insert

* Delete

e Cut to Clipboard
* Copy to Clipboard

e Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Set
List or selection of Set Lists to activate the Set List's Context Sensitive Menu.

You can DRAG COPY Programs and and Combis onto Set List Slots to set the references to them.

Program Editing Features
Program Bank Collection Editing Features

kronos.factory supports the following editing operations upon the Program Bank Collection shown within
the Tree View or Table View of a Child Window:

e Copy/Move

e |nitialise

e Delete

¢ Add EXi Bank - if there are unused banks within the file, then the unused bank names are presented
as sub menu items for selection to create a new bank

¢ Add HD-1 Bank - if there are unused banks within the file, then the unused bank names are presented
as sub menu items for selection to create a new bank

e Cut to Clipboard

. lipboard

¢ Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Program Collection to activate the Program Collection's Context Sensitive Menu.
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Program Bank Editing Features

kronos.factory supports the following editing operations upon the Program Banks shown within the Tree View

or Table View of a Child Window:

e Copy/Move

e Initialise

¢ Renumber - if there are unused banks within the file, then the unused bank numbers are presented as
sub menu items for selection to allow this bank to be renumbered

* Delete

¢ Change to EXi Bank (for an existing HD-1 bank) - Changes the bank type. All Programs are initialised.

¢ Change to HD-1 Bank (for an existing EXi bank) - Changes the bank type. All Programs are initialised.

e Sort by Name

e Sort by Category

e Cut to Clipboard

* Copy to Clipboard
¢ Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Program Collection to activate the Program Collection's Context Sensitive Menu.

Program Editing Features

kronos.factory supports the following editing operations upon the Program Objects within the Tree View

or Table View of a Child Window:

e Copy/Move

o |nitialise

e Rename

e Insert

* Delete

o | ist References

e Cut to Clipboard

* Copy to Clipboard

¢ Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Program or selection of Programs to activate the Program's Context Sensitive Menu.

In the Tree View you can drill down further into the structure of a Program. All objects will support:

¢ Copy/Move

¢ |nitialise

e Cut to Clipboard

* Copy to Clipboard

e Paste from Clipboard

Where there are several similar objects in a list (e.g. Insert Effects, HD-1 Oscillator Trigger Zones, etc.) then
the following options are also available.

e Insert
* Delete

You can DRAG COPY a single Program onto a Combi Timbre or a Set List Slot to set the reference to the
Program.

You can DRAG COPY a single Wave Sequence or Drum Kit onto a HD-1 Oscillator Trigger Zone, depending
on the oscillator mode to set the reference to the Wave Sequence or Drum Kit. A Drum Kit can only be
dropped onto the first trigger zone.

You can DRAG COPY/MOVE common data between Programs and Combis, such as effects, controllers, etc.

Combi Editing Features
Combi Bank Collection Editing Features

kronos.factory supports the following editing operations upon the Combi Bank Collection shown within
the Tree View or Table View of a Child Window:

e Copy/Move

o |nitialise

® Delete

¢ Add Combi Bank - if there are unused Combi banks within the file, then the unused bank numbers are
presented as sub menu items for selection to allow banks to be added

e Cut to Clipboard
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° li r
¢ Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Combi Collection to activate the Combi Collection's Context Sensitive Menu.

Combi Bank Editing Features

kronos.factory supports the following editing operations upon the Combi Banks shown within the Tree View

or Table View of a Child Window:

e Copy/Move

o |nitialise

¢ Renumber - if there are unused banks within the file, then the unused bank numbers are presented as
sub menu items for selection to allow this bank to be renumbered

* Delete

e Sort by Name

e Sort by Categor

* Cut to Clipboard

e Copy to Clipboard

¢ Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Combi Collection to activate the Combi Collection's Context Sensitive Menu.

Combi Editing Features

kronos.factory supports the following editing operations upon the Combi Objects within the Tree View
or Table View of a Child Window:

/Mov:
Initialise
Rename

E

e o 0o o0

]

Delete
o | ist References
* Cut to Clipboard
e Copy to Clipboard
o Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Combi or selection of Combis to activate the Combi's Context Sensitive Menu.

In the Tree View you can drill down further into the structure of a Combi. All objects will support:

e Copy/Move
o |nitialise
¢ Cut to Clipboard
[ ]

ipboard
¢ Paste from Clipboard

=3 e;

Where there are several similar objects in a list (e.g. Insert Effects, Combi Timbres, etc.) then the following
options are also available.

e |nsert
e Delete

You can DRAG COPY a single Combi onto a Set List Slot, to set the reference to the Combi.
You can DRAG COPY a single Program onto a Combi Timbre Slot to set the reference to the Program.

You can DRAG COPY/MOVE common data between Programs and Combis, such as effects, controllers, etc.

Drum Kit Editing Features

kronos.factory supports the following editing operations upon the Drum Kit Bank Collection shown within
the Tree View or Table View of a Child Window:

e Copy/Move

e Initialise

¢ Delete

e Add Drum Kit Bank - if there are unused Drum Kit banks within the file, then the unused bank
numbersI are presented as sub menu items for selection to allow banks to be added

* Cut to Clipboard

® Copy to Clipboard
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To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Drum Kit Collection to activate the Drum Kit Collection's Context Sensitive Menu.

kronos.factory supports the following editing operations upon the Drum Kit Banks shown within the Tree

View or Table View of a Child Window:

e Copy/Move

o |nitialise

¢ Renumber - if there are unused banks within the file, then the unused bank numbers are presented as
sub menu items for selection to allow this bank to be renumbered

* Delete

e Sort by Name

e Cut to Clipboard

* Copy to Clipboard

¢ Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Drum Kit Collection to activate the Drum Kit Collection's Context Sensitive Menu.

kronos.factory supports the following editing operations upon the Drum Kit Objects within the Tree View
or Table View of a Child Window:

o | ist References

* Cut to Clipboard

e Copy to Clipboard

¢ Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Drum
Kit or selection of Drum Kits to activate the Drum Kit's Context Sensitive Menu.

In the Tree View you can drill down further into the structure of a Drum Kit. All objects will support:

e Copy/Move

o |nitialise

¢ Cut to Clipboard

* Copy to Clipboard

¢ Paste from Clipboard

(@

Where there are several similar objects in a list (e.g. Drum Notes, Trigger Zones, etc.) then the following
options are also available.

e |nsert
e Delete

You can DRAG COPY a single Drum Kit onto a HD-1 Oscillator Trigger Zone (the first one only), to set the
reference to the Drum Kit.

Drum Pattern Editing Features

Note: Any editing operating will renumber the drum patterns so that they are consecutively numbered. The
reason for doing this is that | could not think of a better way of keeping what is an ordered list in the synth in
order when you move Objects, insert or delete Objects, Sort Objects, etc. The PCG file only stores the active
drum patterns, so you can have quite large gaps in the numbering. | have assumed that given kronos.factory's
ability to adjust the drum pattern references in Programs and Combis, then the precise drum pattern number
is not of huge interest to users. | am of course open to suggestions on this!

kronos.factory supports the following editing operations upon the Drum Pattern Bank Collection shown
within the Tree View or Table View of a Child Window:

e Copy/Move

e Initialise

e Delete

. RenumbNer - Renumbers all Drum Patterns, starting from Index 0 and consecitively renumbering them
e Sort by Name

e Cut to Clipboard

e Copy to Clipboard

e Paste from Clipboard
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To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Drum Pattern Collection to activate the Drum Pattern Collection's Context Sensitive Menu.

kronos.factory supports the following editing operations upon the Drum Pattern Banks shown within the Tree
View or Table View of a Child Window:

o /Mov:
o |nitialise

e Rename
[ ]

E

]

e Delete

o | ist References

* Cut to Clipboard

e Copy to Clipboard

o Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Drum Pattern Collection to activate the Drum Pattern Collection's Context Sensitive Menu.

kronos.factory supports the following editing operations upon the Drum Pattern Objects within the Tree View
or Table View of a Child Window:

e Copy/Move
e |nitialise
[ ]

Delete
e Cut to Clipboard
o | I

¢ Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Drum
Pattern or selection of Drum Patterns to activate the Drum Pattern's Context Sensitive Menu.

]

You can DRAG COPY a single Drum Pattern onto a Program/Combi Drum Track, to set the reference to the
Drum Pattern.

Wave Sequence Editing Features

kronos.factory supports the following editing operations upon the Wave Sequence Bank Collection shown
within the Tree View or Table View of a Child Window:

e Copy/Move

e |nitialise

e Delete

¢ Add Wave Sequence Bank - if there are unused Wave Sequence banks within the file, then the
unused tl)ank numbers are presented as sub menu items for selection to allow banks to be added

* Cut to Clipboard

e Copy to Clipboard

¢ Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Wave Sequence Collection to activate the Wave Sequence Collection’'s Context Sensitive Menu.

kronos.factory supports the following editing operations upon the Wave Sequence Banks shown within
the Tree View or Table View of a Child Window:

e Copy/Move

o |nitialise

e Renumber - if there are unused banks within the file, then the unused bank numbers are presented as
sub menu items for selection to allow this bank to be renumbered

e Delete

e Sort by Name

e Cut to Clipboard

* Copy to Clipboard

e Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Wave Sequence Collection to activate the Wave Sequence Collection’s Context Sensitive Menu.

kronos.factory supports the following editing operations upon the Wave Sequence Objects within the Tree
View or Table View of a Child Window:

¢ Copy/Move

e [nitialise

e Rename

kronos.factory Program Features 45



¢ |nsert

e Delete

o | ist References

* Cut to Clipboard

* Copy to Clipboard

o Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Wave
Sequence or selection of Wave Sequences to activate the Wave Sequence's Context Sensitive Menu.

In the Tree View you can drill down further into the structure of a Wave Sequence. All objects will support:

e Copy/Move

e |nitialise

¢ Cut to Clipboard

* Copy to Clipboard

¢ Paste from Clipboard

Where there are several similar objects in a list (e.g. Wave Sequence Steps, etc.) then the following options
are also available.

¢ |nsert
e Delete

You can DRAG COPY a single Wave Sequence onto a HD-1 Oscillator Trigger Zone, to set the reference to
the Wave Sequence.

Global Editing Features

kronos.factory supports the following editing operations upon the Global Bank Collection shown within
the Tree View or Table View of a Child Window:

e Copy/Move
o |nitialise
elete

Cut to Clipboard
* Copy to Clipboard

e Paste from Clipboard

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Global Collection to activate the Global Collection's Context Sensitive Menu.
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Preferences
V1.0 note: Some options listed here are for future program features, so may have no effect in V1.0

The kronos.factory preferences are accessed via the Preferences ... option on the View menu or the
kronos.factory Application Menu on OS X, or the E button on the Toolbar.

Selecting this option opens a Tabbed dialog with the following tabs which group related parameters:

e Program Preferences

e Combi/Timbre Preferences

e Set List Preferences

e Wave Segeunce Preferences

o Default View Preferences
o Miscellaneous Preferences

To view and modify a set of parameters, click on the relevant tab.

Note: The options to update Objects following an Object move within the same file (e.g. Update Programs
after Wave Sequence Move) also apply when Objects that can be referenced are inserted, deleted and
sorted.

Note: The options to copy referenced Objects with "parent” Objects (e.g. moving Programs with Combis) work
by:

e Checking the destination file to see if the referenced Object exists

¢ [f it does then the parent Object is updated after being moved to point to the existing Object in the
destination file

¢ |f not then kronos.factory checks to see if a blank or empty child Object is present in the destination
file (e.g. in the case of moving a Program, a blank "INIT PROGRAM" is looked for)

¢ |f a blank Object is found then the child Object is copied and the parent Object is updated after being
moved to point to the new Object in the destination file

¢ |f no blank Obiject is found the kronos.factory gives up. Note this may result in a Partial edit (e.g. it
may have only been possible to copy a subset of Objects due to the amount of free Objects in the
destination file)

* The child Objects are only ever copied irrespective of whether the parent Object is being moved or
copied. This is to avoid the problem that would occur when a child Object is moved (say a Program
with Combi 1), where the source child Object (which would have been initialised after the move) is
also referenced by other Parent Objects (e.g. another Combi)

All the above options are sensitive to what is being dragged. For example a Combi Timbre, Combi Timbre
Branch, Combi, Combi Bank or Combi Banks Branch can be dragged and the necessary Objects will be
copied

Finally, it's worth noting that if the options are all set then everything needed is copied. For example if you

drag a Set List to a new file, then potentially, Combis used in the Set List Slots, Programs used by the Combis
Wave Sequences used by the Programs, etc are all copied. This is a feature I've long been desperate for!
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Program Preferences

The Program Preferences tab is shown below:

W Combi/Timbre Preferences

Update Programs After Wave Sequence Move
Update Programs After Drum Kit Move
Update Programs After Drum Patterm Move

Update Programs After KARMA Generated Effect Move

This tab has the following options:

kronos.factory Preferences

Set List Preferences Default View Preferences Misc Preferences

Copy Wave Sequences With Program
Copy Drum Kits With Program
Copy Drum Pattern With Program

Copy KARMA Cenerate Effect With Program

Ok Cancel

Update Programs After Wave
Sequence Move

If you move a Wave Sequence within a PCG file then the Programs that
use Wave Sequences are updated to ensure that the correct references
to the Wave Sequences are maintained.

Update Programs After Drum Kit
Move

If you move a Drum Kit within a PCG file then the Programs that use
Drum Kits are updated to ensure that the correct references to the Drum
Kits are maintained.

Update Programs After Drum
Pattern Move

If you move a Drum Pattern within a PCG file then the Programs that use
Drum Patterns are updated to ensure that the correct references to the
Drum Patterns are maintained.

Update Programs After KARMA
GE Move

If you move a KARMA GE within a PCG file's associated KGE File then
the Programs that use KARMA GEs are updated to ensure that the
correct references to the KARMA GEs are maintained.

NOTE: This setting currently has no effect, as currently KGE files cannot
be edited

Copy Waves Sequences With
Program

If you move or copy a Program from one PCG file to another PCG file,

then any Wave Sequences referenced by the Program are also copied
to the destination file if the Wave Sequences are not already present in
the destination file.

Copy Drum Kits With Program

If you move or copy a Program from one PCG file to another PCG file,
then any Drum Kits referenced by the Program are also copied to the
destination file if the Drum Kits are not already present in the destination
file.

Copy Drum Patterns With
Program

If you move or copy a Program from one PCG file to another PCG file,
then any Drum Patterns referenced by the Program are also copied to
the destination file if the Drum Patterns are not already present in the
destination file.

Copy KARMA GEs With Program

If you move or copy a Program from one PCG file to another PCG file,
then any KARMA GEs referenced by the Program are also copied to the
destination file's associated KGE File if the KARMA GEs are not already
present in the destination file's associated KGE File.

NOTE: This setting currently has no effect, as currently KGE files cannot

be edited
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Combi Preferences

The Combi Preferences tab is shown below:

@

kronos.factory Preferences

Program Preferences [RECul-RRglRa{deao0  Set List Preferences  Default View Preferences  Misc Preferences

Update Combis After Program Move

Copy Programs With Combi

Update Combis After Drum Pattern Move Copy Drum Pattern With Combi
Update Combis After KARMA Generated Effect Move Copy KARMA GCenerated Effect With Combi
Ok Cancel

This tab has the following options:

Update Combis After Program
Move

If you move Programs within a PCG file then the Combis that reference
the updated Programs are updated to ensure that the correct references
to the Wave Sequences are maintained.

Update Combis After Drum
Pattern Move

If you move a Drum Pattern within a PCG file then the Combis that use
Drum Patterns are updated to ensure that the correct references to the
Drum Patterns are maintained.

Update Combis After KARMA GE
Move

If you move a KARMA GE within a PCG file's associated KGE File then
the Combis that use KARMA GEs are updated to ensure that the correct
references to the KARMA GEs are maintained.

NOTE: This setting currently has no effect, as currently KGE files cannot
be edited

Copy Programs With Combi

If you move or copy a Combi from one PCG file to another PCG file, then
any Programs referenced by the Combi are also copied to the
destination file if the Programs are not already present in the destination
file.

Copy Drum Patterns With Combi

If you move or copy a Combi from one PCG file to another PCG file, then
any Drum Patterns referenced by the Combi are also copied to the
destination file if the Drum Patterns are not already present in the
destination file.

Copy KARMA GEs With Combi

If you move or copy a Combi from one PCG file to another PCG file, then
any KARMA GEs referenced by the Combi are also copied to the
destination file's associated KGE File if the KARMA GEs are not already
present in the destination file's associated KGE File.

NOTE: This setting currently has no effect, as currently KGE files cannot

be edited
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Set List Preferences

The Set List Preferences tab is shown below:

@

kronos.factory Preferences

Program Preferences Combi/Timbre Preferences ‘W Default View Preferences Misc Preferences

Update SetLists After Program Move

Update SetLists After Combi Move

Update SetLists After Song Move

This tab has the following options:

Copy Programs With SetList
Copy Combis With SetList

Copy Songs With SetList

Ok Cancel

Update Set Lists After Program
Move

If you move Programs within a PCG file then the Set Lists that reference
the updated Programs are updated to ensure that the correct references
to the Wave Sequences are maintained.

Update Set Lists After Combi
Move

If you move a Combi within a PCG file then the Set Lists that use
Combis are updated to ensure that the correct references to the Combis
are maintained.

Update Set Lists After Song
Move

If you move a Song within an associated Song file then the Set Lists that
use Songs are updated to ensure that the correct references to the
Songs are maintained.

NOTE: This setting currently has no effect, as currently Song files are
not supported

Copy Programs With Set List

If you move or copy a Set List from one PCG file to another PCG file,
then any Programs referenced by the Set List are also copied to the
destination file if the Programs are not already present in the destination
file.

Copy Combis With Set List

If you move or copy a Set List from one PCG file to another PCG file,
then any Combis referenced by the Set List are also copied to the
destination file if the Combis are not already present in the destination
file.

Copy Songs With Set List

If you move or copy a Set List from one PCG file to another PCG file,
then any Songs referenced by the Set List are also copied to the
destination file's associated song file if the songs are not already present
in the destination file.

NOTE: This setting currently has no effect, as currently Song files are

not supported
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Default View Preferences

The Default View Preferences tab is shown below:

[ ] kronos.factory Preferences
Program Preferences Combi/Timbre Preferences Set List Preferences Misc Preferences
Default View NoSplit - - - - ) B
Pane Tree View | T
Default Library View | ng split x
Library Pane | Tree View <
View Tool Bar
View Status Bar
View Backdrop In Child Window
Ok Cancel
Default View Defines the type of view that is applied to a Child Window when it is first

opened.
The following options are available:
* No Split

¢ Horizontal Split
e Vertical Split

Pane/Left Pane/Top Pane

Defines the type of view shown in the single pane of an unsplit view, the
left pane of a horizontally split view or the top pane of a vertically split
view.

The following options are available:

* Tree View
e Table View

Right Pane/Bottom Pane

This control is only visible if the Default View option is set to either
Horizontal Split or Vertical Split.

Defines the type of view shown in the right pane of a horizontally split
view or the bottom pane of a vertically split view.

The following options are available:

* Tree View

e Table View
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Default Library View

Defines the type of view that is applied to the Kronos Library Window
when it is first opened.

The following options are available:
¢ No Split

¢ Horizontal Split
e Vertical Split

Library Pane/Library Left
Pane/Library Top Pane

Defines the type of view shown in the single pane of an unsplit view, the
left pane of a horizontally split view or the top pane of a vertically split
view.

The following options are available:

* Tree View
e Table View

Library Right Pane/Library
Bottom Pane

This control is only visible if the Default Library View option is set to
either Horizontal Split or Vertical Split.

Defines the type of view shown in the right pane of a horizontally split
view or the bottom pane of a vertically split view.

The following options are available:

* Tree View
e Table View

View Tool Bar

Controls if the toolbar is visible at startup.

View Status Bar

Controls if the status bar is visible at startup.

View Backdrop In Child Window

This option controls if the image backdrop is displayed in Child Windows.

You may wish to turn off this option if you find the scrolling of the Child
Window is slow on your machine.
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Miscellaneous Preferences

The Miscellaneous Preferences tab is shown below:

@

Program Preferences

Combi/Timbre Preferences

kronos.factory Preferences

Set List Preferences

Default View Preferences | Misc Pref i- rence i

Startup Directory ‘

/Development/Kronos

Global Settings
Sample Load Options No

KARMA Load Options No

‘,f Development/Kronos {CONTENT TEST,/GLOBAL.PCC

Load Last File On Startup

Check For Duplicates When Moving or Copying Objects

Warn if Destination Object is Referenced When Moving or Copying Objects

This tab has the following options:

Ok Cancel

Startup Directory

Allows the startup directory to be specified. Note: no validation is
performed on this pathname, so please ensure it is valid. | may add
validation later.

The [...] button to the right of the field brings up a dialog that allows you
to select the directory instead of typing it in.

Global Settings

Specifies the file from which Global Settings will be loaded, to get your
Program and Combi Categories and Sub Categories, if the current PCG
does not have the Global Settings stored within in.

The [...] button to the right of the field brings up a dialog that allows you
to select the file instead of typing it in.

Sample Load Options

Determines what kronos.factory does with Sample (KSC) files when
loading PCG files, if a KSC file is found in the same directory as the
PCG file and with the same name. You can select the behaviour from
the following choices:

¢ No - Sample files are not loaded

e Yes - Sample files are automatically loaded

¢ Confirm - kronos.factory asks you if you wish to load a sample
file

KARMA Load Options

Determines what kronos.factory does with KARMA (KGE) files when
loading PCG files, if a KGE file is found in the same directory as the
PCG file and with the same name. You can select the behaviour from
the following choices:

* No - KARMA KGE files are not loaded

¢ Yes - KARMA KGE files are automatically loaded

¢ Confirm - kronos.factory asks you if you wish to load a KARMA
KGE file

Load Last File On Startup

Controls if the last file opened in the previous session is automatically
loaded when kronos.factory is next invoked.

Check For Duplicates When
Moving or Copying Objects

If you move or copy an Object to a destination file and the Object already
exists then a warning is presented giving you the option to continue or
cancel the operation.

Warn if Destination Object is
Referenced When Moving or
Copying Objects

If you move or copy an Object and it is overwriting an Object that is
being referenced, or you are deleting a referenced Object, then a
warning is presented giving you the option to continue or cancel the
operation.
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Online Help
kronos.factory provides a full online version of the kronos.factory manual.

If you select Help ... from the Help Menu or the  button on the Tool Bar, the Help Window is opened.

[ JON kronos.factory - Help
< > #® ||
GO 4 "Welcome to kronos.factory
-.

kE

What's New
Installing and Configuring ex.fact
Registering ex.factory
Running ex.factory
| Window
|| Program Features
| 7 Preference Settings
Online Help
Tips And Tricks
About Dialog
Glossary of Terms
Keyboard Shortcuts
EX5 MIDI Issues =
Credits Introduction

License Agreement

kronos.factory is a cross platform Librarian for the Kronos synthesizer, that allows you to
organise your Kronos data from the comfort of your computer.

The Help Window works just like a web browser window, so its operation should be quite familiar to you.

The left pane of the Help Window shows a tabbed navigation pane to allow you to quickly navigate to a topic,
whilst the right hand pane shows the help topic.

The navigation pane can show three different views, depending on which tab you select:
of '. Displays the Table of Contents Navigation Pane, providing a structured list of kronos.factory

t
. ﬁ’s Displays the Index Navigation Pane, providing an indexed list of kronos.factory topics
e & | Displays the Search Navigation Pane, allowing you to search the help topics for keywords

The Help Window has the following Tool Bar buttons:

* € Navigates backwards to the last page in the access sequence. If you press and hold the mouse
button over this button, you will get a list of accessed pages

¢ » Navigates forwards to the next page in the access sequence. If you press and hold the mouse
button over this button, you will get a list of accessed pages

e & Selects the home page

e % Refreshes the current page

¢ 5  Prints the current page

o & Displays the print settings dialog

Context Sensitive Help
You can access context sensitive help by:

e pressing the your Computer Platform's Help Key ( F1 on the PC platform), which will load the help
page associated with the Component within the kronos.factory Window that currently has Focus (is
responding to the keyboard and mouse).

« pressing the %2 button on the Tool Bar and the clicking over the item of interest

You can press the Help Key in any kronos.factory Dialog to access the relevant help page for the Dialog.
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Tips and Tricks
The kronos.factory tips and tricks dialog is shown below:

[ NON ) kronos.factory Tips and Tricks

Keyboard Shortcuts

kronos.factory supports numerous keyboard shortcuts as an alternative to using the mouse.

Take a look in the online help or the kronos.factory manual for details of the supported keyboard shorteuts

Close Next Tip Show Tips at Startup

This dialog has the following controls:

Close Closes the Tips and Tricks Dialog

Next Tip Selects the next tip in sequence

Show Tips at If checked then when kronos.factory starts up, the Tips and Tricks Dialog is automatically
Startup opened

List of Tips and Tricks

Just in case you want the tips and tricks shown by the dialog as one single list, here they are.

Context Sensitive Help

If you press the Help Key ( F1 on a PC) then you can get context sensitive help, including within Dialogs.

Keyboard Shortcuts
kronos.factory supports numerous keyboard shortcuts as an alternative to using the mouse.

Take a look in the online help or the kronos.factory manual for details of the supported keyboard shortcuts

Object Colouring
If an Object such as a Wave or Program is coloured blue, then it is being referenced by another Object.

If you right click over a blue Object you'll find a "List References" context menu, which will show you the
Objects that reference this one.

Find/Find Next Category Tool Bar Buttons

If you hold the SHIFT key down whilst pressing the Find or Find Next tool bar button the operations
performed change from:

¢ Find to Find Category
¢ Find Next to Find Next Category

Table Sorting
You can sort Tables by clicking in the Table Column headers.

For example, if you click in the Category Column then the Table will be sorted by Category

You can only DRAG COPY Certain Objects

If you are trying to perform a drag operation on certain data types and are wondering why kronos.factory is not
allowing you to perform the drag, try holding down the CTRL key during the drag to see if this is then allowed.
Holding down the CTRL key turns the operation from a Drag Move operation to a Drag Copy operation.

Sometimes during a drag operation, the only sensible operation that can be undertaken is a copy operation,
for example:
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Copying/Moving Objects to a Different File

When you copy an Object to a different file then any Objects it references can also be copied at the same
time.

For example of you move a Combi to a new File, then the following Objects are also copied (assuming they
are present within the file):

¢ The referenced Drum Kit if it is a User Drum Kit

e Any User Programs referenced by the Combi Timbres

¢ Any User Waves Sequences referenced by the Programs
| think you'll agree this is a cool feature!

This feature can be selectively turned off for different Object types if required within the Preferences Dialog.

Workspaces

kronos.factory allows you to save a Window arrangement as a Workspace which you can then recall at a
later date.

Moving Objects within a File

When you move an Object within a file then any Objects that reference the Object type being moved can be
updated to ensure they all still reference the correct objects after the move.

For example of you move a Program within a file then all the Combi Timbres are updated
I think you'll agree this is a cool feature!

This feature can be selectively turned off for different Object types if required within the Preferences Dialog.

KSC File Loading

If you have a KSC file in the same directory as your PCG file with the same name (e.g. mysounds.pcg,
mysounds.ksc) then kronos.factory can load that file automatically as part of the PCG data if you have set the
Sample Load Options in the kronos.factory Preference settings to Yes. Setting the same option to Confirm
will allow you to confirm the choice when the files are loaded.

KGE File Loading
If you have a KGE file in the same directory as your PCG file with the same name (e.g. mysounds.pcg,
mysounds.kge) then kronos.factory can load that file automatically as part of the PCG data if you have set the

KARMA Load Options in the kronos.factory Preference settings to Yes. Setting the same option to Confirm
will allow you to confirm the choice when the files are loaded.

"Read only" Data

In this version of kronos.factory, KSC and KGE files can be loaded, but currently the contents of these files
are "read only". This means that you can view the contents, but you cannot edit it. kronos.factory will also use
the data, for example to display sample names in HD-1 Oscillator trigger zones.

Such read only data is highlighted in red text with a yellow background
PCG File Formats

Whilst kronos.factory was written primarily with OS Version 3 files in mind, | have provided legacy OS file
support for the older file versions for OS 1.5 and OS 2.0 as a lot of the publicly available Kronos files are
provided in these formats.

kronos.factory will preserve the format that a file is in. When you copy data between files of different formats
then it is converted to the later format. You can only copy from older to later file formats
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About kronos.factory

The about dialog is shown when the About ... option from the Help Menu or the % button on the Tool Bar is
selected.

[ ] About kronos.factory

kronos.factory: the Korg Kronos Librarian
Build 0.0.02 - (C) 2017 Derek Cook
Written by Derek Cook
www.xfactory-librarians.co.uk

Graphics by Torus and Ski
kronos.factory is programmed in Java 7

The JRE Version is 1.8.0_71
The CoreMIDI4) Library Version is 1.1

License Key: DIN7E-CK4UJ-NRSWF-KUUPV-BELHE
Registered to: Derek Cook

The dialog shows some basic information about the program including the version number and the License
status of kronos.factory.

It also shows which Java Run Time Environment that kronos.factory is running in.
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Glossary

|Term |Definition |

Glossary
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Keyboard Short Cuts

kronos.factory provides many keyboard shortcuts for navigation and performing editing operations.
In general, navigating between components uses these keys:

¢ Tab. Moves keyboard focus to the next component or to the first member of the next group of
components.

¢ Ctrl-Tab. Moves keyboard focus to the next component or to the first member of a group of
components when the current component accepts a tab (as in text fields, tables, and tabbed panes).

* Shift-Tab. Moves keyboard focus to the previous component or to the first component in the previous
group of components.

¢ Arrow keys. Move keyboard focus within the individual components of a group of components--for
example, within menu items in a menu or within tabs in a tabbed pane.

The shortcuts are divided into the following categories:

» Keyboard shortcuts for the Desktop and Child Wndows
Keyboard shortcuts for Tree Views

[ )
o Keyboard shortcuts for Table Views

¢ Keyboard shortcuts for Editing within Tree and Table Views
. S

. S

Keyboard shortcuts for the Preferences Dialog
Keyboard shortcuts for Text Editing Fields

Keyboard Shortcuts for the Desktop and Child Windows

Action Keystroke Notes
New File Ctrl-N
Open File Ctrl-O
Save File Ctrl-S
Save File As Ctrl-A
Save All Files Ctrl-L
Open Workspace Ctrl-ALT-O
Save Workspace Ctrl-ALT-S
Tile Horizontally Ctrl-H

Tile Vertically Ctrl-V
Maximise Windows Ctrl-M
Restore Windows Ctrl-R
Minimise Windows Ctrl-1
Closes Child Window Ctrl-F4
Moves Child Window Ctrl-F7
Resizes Child Window Ctrl-F8
Minimizes Child Window Ctrl-F9
Switch to next Child Window on the Ctrl-F6
Desktop
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Keyboard Shortcuts for Tree Views

Action Keystroke Notes

Expands current Object Right arrow

Collapses current Object, or moves focus | Left arrow
to Parent Object

Moves focus up one Object Up arrow

Moves focus down one Object Down arrow

Moves focus to first Object in Tree View |Home

Moves focus to last Object in Tree View |End

Moves up one view Page Up

Moves down one view Page Down

Selects all Object in Tree View Ctrl-A, Ctrl-/

Deselects all Object in Tree View Ctrl-\

Extends selection down Shift-down
arrow

Extends selection up Shift-up arrow

Extends selection to beginning of Tree Shift-Home
View

Extends selection to end of Tree View Shift-End

Extends selection up one view Shift-PgUp

Extends selection down one view Shift-PgDn
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Keyboard Shortcuts for Table Views

Action Keystroke Notes

Moves up one row Up arrow
Shift-Return

Moves down one row Down arrow
Return

Scrolls up one view Page Up

Scrolls down one view Page Down

Moves focus and view to first cell in the Home

current row

Moves focus and view to last cell in the End

current row

Moves focus and view to first cell in the | Ctrl-Home

current column

Moves focus and view to last cell in the Ctrl-End

current column

Allows editing in a Category cell

F2, Down Arrow

Allows editing in a Name cell.

F2

Resets cell to the state it was in before it | Escape

was edited

Selects entire table Ctrl-A

Extends selection up one row Shift-up arrow

Extends selection down one row Shift-down
arrow

Extends selection to beginning of table

Ctrl-Shift-Home

Extends selection to end of table

Ctrl-Shift-End

Extends selection up one view

Shift-PgUp

Extends selection down one view

Shift-PgDn

Keyboard Short Cuts
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Keyboard Editing Short Cuts for both Tree and Table Views

Action Keystroke Notes

Undo Ctrl-Z

Redo Ctrl-Y

Cut Ctrl-X

Copy Ctrl-C

Paste Ctrl-V

Find Ctrl-F

Find Next F3

Find Category Ctrl-Shift-F

Find Next Category Shift-F3

Goto Ctrl-G

Insert Object INS Not allowed on
Collections

Delete Object DEL Not allowed on
Collections

Rename Object F4 Single Named Object
Only

Initialise Object F5

List References F6 Single Named Object
Only

Map To Flash F7

Map To Ram Shift-F7

Export to MIDI Edit Buffer F8 Single Voice or
Performance Only

Export to MIDI Memory Shift-F8 Voices or
Performances Only

Import from MIDI Edit Buffer F9 Single Voice or
Performance Only

Import from MIDI Memory Shift-F9 Voices or

Performances Only

Keyboard Short Cuts
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Keyboard Shortcuts for the Preferences Dialog

Action Keystroke Notes

Navigates through tabs Arrow keys

Moves from tab to its associated content | Ctrl-down arrow
pane

Moves from content pane to its Ctrl-up arrow
associated tab

Keyboard Shortcuts for Text Editing Fields

Action Keystroke Notes

Moves insertion point one character to Right arrow
the right

Moves insertion point one character to Left arrow

the left

Moves insertion point to beginning of Ctrl-right arrow
next word

Moves insertion point to beginning of Ctrl-left arrow
previous word

Moves insertion point to beginning of Home

field

Moves insertion point to end of field End

Submits text entry Enter, Return
Extends selection to beginning of line Shift-Home
Extends selection to end of line Shift-End

Extends selection one character to the Shift-left arrow
left

Extends selection one character to the Shift-right arrow
right

Extends selection to next word Shift-Ctrl-right
arrow

Extends selection to previous word Shift-Ctrl-left
arrow
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Credits

Thanks go, in no particular order, to:

e Galf2 for assistance in beta testing.
e Korg for making such a fantastic synthesizer in the Kronos

3rd party software used in kronos.factory

The following 3rd part software is used to build kronos.factory and provide some program features.

CoreMIDI4J License

kronos.factory makes use of CoreMIDI4J to provide MIDI support on OS X, which is issued under the EPL 1.0
License.

Table Filter License
kronos.factory makes use of TableFilter by Luis M. Pena, which is issued under the MIT License.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Apache Derby License

kronos.factory makes use of Apache Derby to provide the library function, which is issued under the Apache
2.0 License.

Apache Log4dJ License

kronos.factory makes use of Apache Log4J to provide logging services, which is issued under the Apache 2.0
License.

Dom4J License

kronos.factory makes use of Dom4J to provide XML services, which is issued under the Maplesoft Dom4J
License.

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS "AS IS" AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Java Wizard License

The kronos.factory Library Batch Importer makes use of the Java Wizard Project which is distributed under
the n rce Initiativ mmon Development and Distribution Li

| have adapted the Wizard software to allow me to display two progress bars in the Wizard. If anybody wishes

to have the source code for how | did this, please email me at supportx@xfactory-librarians.co.uk and | will
happily provide the adapted source code.
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kronos.factory License

The unregistered version of kronos.factory allows you to evaluate the features of the program, which are fully
functional except the File Save, MIDI Export and Librarian features.

However, kronos.factory cannot be included as part of a commercial distribution or on other web sites without
the express permission of the Author. | am happy for you to provide links to www.xfactory-librarians.co.uk, to
maximise public access to kronos.factory.

kronos.factory license files are issued to users who have registered kronos.factory, to gain access to the File
Save, MIDI Export and Librarian features. If you have been issued with a license key you are not allowed to
distribute a license key to other users. Please respect this, and the amount effort | have put into making this
application.

You are permitted to install and activate kronos.factory on two computers, for which the license is valid.

If you wish to install and activate kronos.factory on more than two computers, then an additional license can
be purchased at 50% of the cost of the main license.

The Author retains the copyright on the program and all of its originally developed features.

Disclaimer

Like all software products, this software is provided "AS IS", and without any warranties expressed or implied.
But hey, remember, you're getting it for a very low cost!

| have worked hard to ensure this software works correctly, as | certainly don't want it trashing my data.
However, | cannot be held liable for any problems arising as a consequence of you using this software on
your computer and your data. You use this product at your risk.

Like all new products, please proceed and evaluate with care, and ensure that all your important data files are
backed up before installation and evaluation.

Having gotten that out of the way, if you do encounter any problems, please submit a bug report
to support@xfactory-librarians.co.uk, and | will endeavour to provide a fix for any reported problems.

Licensing Conditions for 3rd party software
Apache Derby License

kronos.factory makes use of Apache Derby to provide the library function, which is issued under the Apache
2.0 License.

Apache Log4dJ License

kronos.factory makes use of Apache Log4J to provide logging services, which is issued under the Apache 2.0
License.

CoreMIDI4J License

kronos.factory makes use of CoreMIDI4J to provide MIDI support on OS X, which is issued under the EPL 1.0
License.

Dom4J License

kronos.factory makes use of Dom4dJ to provide XML services, which is issued under the Maplesoft Dom4J
License.

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS "AS IS" AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Java Wizard License

The kronos.factory Library Batch Importer makes use of the Java Wizard Project which is distributed under
the Open Source Initiative Common Development and Distribution License.

Table Filter License
kronos.factory makes use of TableFilter by Luis M. Pena, which is issued under the MIT License.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Tritonus License

kronos.factory makes use of Tritonus Java Sound Extensions, which is issued under the GNU Lesser General

Public License.

kronos.factory License
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